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SYSTEMS

TEST SUBMISSIONS

Samples are sent to labs which analyze the sample for different values (like nutrient levels, pH level)
and report their findings to the retailer. These findings can then be downloaded, or imported, into agré
and are available for future crop planning, etc.

For participating labs, agré has the ability to submit a test to the lab electronically. The general work
flow is as follows:

e agronomist logs into agré and submits the sample info to the lab
e agre generates submission form and stickers for the sample bags
(no stickers are required for tissue test submissions)
e agronomist applies stickers to the bags, attaches the form, and ships the package off to the lab
e lab receives and tests the samples
e test results are then made available to agronomist through agré’s web service
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Test Lab Submission Security

On the Agronomy tab, allow permission to applicable security items.

*~ Edit Role: LordOfTheUniverse [ -E- | Se]
‘HSEI\I'B |>‘<_Dele¢e ‘gEmt ‘

[
Raole  Pemissions ] &

" Accourts Receivable ] Inverrton.r] Arccounts Payable  General Ledger | Blending  Agronomy ]Administmtion ]

[tem Action Alow? | Deny? | =
Soil Test Submission Add |
- P Delete |
required for submissions e &

Soil Tests Add o 4
Delete (]

! required for results retrieval || Enable on menu ] -

File > Security > Manage Roles / Agronomy tab

Save your changes.

Manage Soil Test Labs

Check Use Lab next to the labs you deal with. Save your changes when you’re done.

» Manage Soil Laboratories =N E=R ="
m Save 6 Exit

Name Use Lab Soil Submit Prefix | Soil Submit Number

> |A&L Canada i e 001
Agvise
ALS Laboratory r
Down to Earth
Exova required for A&L only
Farmers Edge
Midwest | |

Agronomy > Manage> Soil Labs
Each test submission must have a unique reference number (just like an invoice or inventory receipt).

A&L requires that YOU give THEM a unique reference number.
The Soil Submit Prefix (maximum of 5 characters) will be provided by A&L.
The Soil Submit Number (maximum of 10 characters) is set by you and will be incremented by one
with each submission.

Midwest applies its own unique reference number to each test you submit and passes that number back
to agre.

Lab Test Submissions Page 2 of 14



Manage Web Service IDs and Passwords (optional)

Note

Currently only A & L Canada and Midwest offer submissions and direct
downloads through agre.

Results from other labs can be downloaded, but they do not accept
submissions.

You may want to pre-populate your user name and password so that you don’t have to type them in each

time you want to submit a test or download the results.

On the User Config Options Agronomy tab, enter the Username and Password provided by the lab and

Save the change.

*» Config Options for User =N =R ==
n Save |_] Start Ower @ Exit

User: [agre User %I

 Miscellansous ] Blending ] Reports ] Email  Agronomy | Advanced |

M apping

% Use Company Zoom
T et I NRVE VY PR
-’ e et T T T T e e T

o e

Sail Test
Soil Lab Credentials:

enter login credentials
Username: | given to you by the
Password: | test lab

File > Config Options > User / Agronomy tab

Tip

If you submit or download test results from both A&L and Midwest you can
skip this step (leave the Username and Password fields blank) and agré will

prompt you to enter your login credentials on the fly when you initiate a
connection.

Lab Test Submissions
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Adding a Test Sample

Soil and tissue tests can be submitted from Agronomy > Submit
Soil/Tissue Tests.

Agronormy

5
B
o

Agronomy Customer Centre
Field Manager
Soil/Tissue Tests

Submit Soil/Tissue Tests

Crop Planning

¥

Click the relevant button, either Add Soil Tests or Add Tissue Tests.

& Soil/Tissue
J &3 Add Sol Tests | o Add Tissue Tests | A Eit ‘ X Delete |M New Search | ] Print Form | ] Print Labels ‘0 Edt ‘

Submit Date  ~ |Lab

Morth\wlest Cancla Feild
Barley Field N\ 2

Sw Quarter
Back 40

SSAL2413

99995-55A1 2418
99995-55A1 2417

Jun 0, 2017 Abraham, James

Jun 05, 2017
Jun 08, 2017

Clark, Bill
Carter, Alexander

Submitted
Submitted

ety 4

41 Seil/Tissue Test Submissions (Incl. 2 Pending) found

Agronomy > Submit Soil/Tissue Tests

Soil Tests (but not tissue tests) can also be added from the grower’s Agronomy Centre.

Add New ltem

Carter, Alexander (00183)

Box 14
Dog River, SK S0K1T3

ﬂg Crop Plan
W Field Scout

yi_ Fields:
B Product Distribution
$ Field Expenze
[EY Field

<All Fields>
Back 40
Bobby's Field

Agronomy > Agronomy Customer Centre

Note

You will not be able to add a submission for a grower with no active farm
fields.
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Submissions for A&L

When you submit a test sample, you’ll need to specify the lab, the customer and the field. You can add
the sample data rows one at a time by typing details directly in the grid, or click Add Multiple Rows to

add several rows with the same data at once.

W Add Soil Test B
Jsubmﬂ |@53"B as Pending ‘ Copy @Mﬁ once submitted, next time you sample you
can copy this one to create a new submission

Laboratory: Iﬁ& L Canada LI :

Customer: ICarter. Alexander (CO874) LI. Find |

Reference: I

Comments:

Sample Number |Farrn Field | Depth Top | Depth Bottom | Package |F{emmmenda‘tions?
>* Bobby’s Field (80 ac) 0 6B il [
add multiple rows with
common details
TPISEOTTRSTRISOTES e =21 [ |< |

Note A&L requires you to supply a Sample Number (letters and dashes are ok too).

No. of Tests is how many sample rows you want to create with this information.

v Add Multiple Rows | || in the information that is common to l
Jo Updaiz). € Exit | all (or most) of the rows you want to add
optional, but No.of Tests: | 5" Field: [Bobby’s Field (80 ac) =]

recommended Frefic: CART. Depth Top: I—n
Start Number: I 20 Depth Bottomn: I 3

must be = 0
Package: jsw1g2 ~|
—Recammendations 7
Previous Crop Canola ﬂ:)
Intended Crop [ Yield| Units |
> iWwhest Red Spring ir| 70 bu

request Recommendations
for up to 3 intended crops

Clear Row |
Y
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A Prefix is optional, but is useful for helping you keep your sample bags organized as it prints on the
bag labels. Allowed characters are letters, numbers, and dashes.

Tip

Think of the prefix as something that identifies the grower. If you've got

dozens of bags on a table, having the customer’s prefix on the label also helps
you organize which bags go together with which test.

The Start Number must be greater than 0. You can have duplicate Prefix+Sample Number
combinations as long as they belong to different Submissions.

For any information that is different for a particular sample, change it directly in the grid.

| e TN P e e e e e T T T, iy e T Tt T T e )
| Sample Mumber | Farm Field | Depth Top | Depth Bottom | Package | Recommendations? |
_| CART-20 Back 40 (40 ac) 0 E SwilB2 [
| CaRT-21 Field #4 - S\ 24-38-20-W5 (1 0 § SwiB2 |
> |CART-22 | 6 12| swiB2 | |
 |CART-23 Back 40 (40 ac) - ) ~ |
| |CART-24 Bobby's Field (80 ac) L 8| Cash Crop Package 1 |
N | Cross Corner - NE 3-52-1 W5 ':| Cash Crop Package 2 [l |
Field #4 - S\ 24-28-20-W5 (125 ac) | Caszh Crop Package 3
Elv Field - SF 12-51-1 /R (95 a¢) ol
if multiple farm fields are selected, the go 52 LHA atio v
submission will split by Farm Field on
Submit or Save as Fend."ng Add Multiple Rows | Edit Recommendations Remove Sample |/
5

Select a row and click Edit Recommendations to change them for just one row.

Submissions for Midwest

Soil Tests

When you submit a test sample, you’ll need to specify the lab, the customer and the field. You can add
the sample data rows one at a time by typing details directly in the grid, or Add Multiple Rows at once.

& Add Soil Test o[- (3]
Submit Q.a‘ Sawve as Pending Copy | |_] Start Over | €3 Bxit
Laboratory: |Midwest j -
Customer: |Carter, Alexander (C0874) | *" Find
Reference:
Comments: |
Sample Number | Farm Field Depth Top | Depth Bottom | Package Recommendations?
5 [
Add Multiple Rc.f.hi | |

Lab Test Submissions
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No. of Tests is the number of sample bags you’re going to submit for testing.

~ Add Multiple Rows ==
@ Updatz € Ext
optional, but Mo ofTests: | 5 Field: |ty Field - SE 12-51-1 W5 (35 ac) |
recommended Prefix: CART- Depth Top: o
@ Start Mumber: ,72[} Diepth Bottom: ,75 -
Package: |S3C Package ﬂ

Recommendations

Intended Crop Yield | Previous Crop
> CANCLA - bu Hhd 60 WHEAT SPRING -bu

request Recommendations

for up to 3 intended crops Clear Row

Y

A Prefix is optional, but is useful for helping you keep your sample bags organized as it prints on the
bag labels.

Tip Think of the prefix as something that identifies the grower. If you’'ve got
dozens of bags on a table, having the customer’s prefix on the label helps you
organize which bags go together with which test.

The Start Number must be greater than 0. Allowed characters are letters, numbers, and dashes.

If any of the information is different for a particular sample, you can change it manually by selecting a
different option directly in the grid.

| Sample Mumber | Farm Field | Depth Top | Depth Bottom | Package | Recommendations? |
| |carT-20 Fly Field - SE 12-51-1 w5 (85 0 6 53C Package |
| caRT-21 Fly Field - 5E 12-51-1 w5 (35 0 6 53C Package |
| |caRT-22 Fly Field - SE 12-51-1 W5 (95 0 & 53C Package |
| |caRT-23 Fly Field - SE 12-51-1 W5 (95 0 q fff ?ff}ff |
Z CART-24 Fly Field - SE 12-51-1 /5 (85 0 {SE Package I =] |
= [l |

Select a row and click Edit Recommendations to change them for just one row.

You can add more rows for different fields. Midwest allows samples for multiple fields on the same
submittal.
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Tissue Tests

& Soil/Tissue Test Submissions E@
J & Add Soil Tests | s Add Tissue Tests !!@g‘ View ‘ ¥ Delete |M New Search Print Form Print Labels ‘Q Exit ‘
Reference Submit Date = |Lab Customer Field Status Type |Sample Count |
SSAL7418 Jun 06,2017 |AL Abraham, James g:ﬁ;ﬂ?ﬂﬁﬁ'g Felld | perding & 2|4
99555-S5AL2418 | Jun 05, 2017 AL Clark. Eill Sw Quarter Submitted U 1
99905-S5AL 2417 | Jun 05, 2017 AL Carter, Alexander Back 40 Submitted U 1=

41 Sail/Tissue Test Submissions (Incl. 2 Pending) found

Agronomy > Submit Soil/Tissue Tests

When you submit a test sample, you’ll need to specify the lab, the customer and the field. You can add
the sample data rows one at a time by typing details directly in the grid, or Add Multiple Rows at once.

.

W Add Tissue Test ﬂ@
JSme“ ‘3 Save as Fending ‘ Eopy H‘G""Q"" once submitted, tissue tests can be copied too
Laboratory: II'U'Iidwest LI -
Customer. [Carter. Alexander (C0874) ~1" Find |
Reference: I
Comments: ’
Sa'ﬂple humber | Farm Field | Crop | Stage | Package
=" W Add Multiple Rows *
Update: /4D Ext |
No. of Tests: E Field: [Field #4 - W 24-38-20W5 (125ac)  +|
Prefix: ICAHT— Crop: |Cano|a j
Start Number: 10 Stage: |ROSETTE ~|
Package: ICompIete j

b
Q{ Liddd Multiple Rows I

No. of Tests is the number of sample bags you’re going to submit for testing.

A Prefix is optional, but may be useful for helping you keep your sample bags organized as it prints on
the bag labels.

The Start Number must be greater than 0. Allowed characters are letters, numbers, and dashes.

A Package must be selected before a submission can be saved as Pending.

Lab Test Submissions
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If any of the information is different for a particular sample, you can change it manually by selecting a
different option directly in the grid.

& Add Tissue Test === ==
Submit Qa‘Save as Pending Copy | |_] Start Over | €3 Bxit

Laboratory: |Midwest j -
Customer: |Carter, Alexander (C0874) | * Find
Reference:
Comments:

Sample Number | Farm Field Crop Stage Package

CART-10 Field #4 - S/ 24-38-20-W5 (1 Cancla ROSETTE (21.2) Complete

CART-11 Field #4 - S\ 24-38-20-W5 (1: Cancla ROSETTE (21.2) Complete
= |CART-12 Field #4 - S\ 24-38-20-W5 (1 Cancla ROSETTE (21.2) |I:nm|:-lete j
- ' ] . ' Complete

rows can be edited VT
Add Multiple Rows | Remaove Sample |

For Soil & Tissue Tests for Both Labs

If the samples aren’t quite ready for submission, you can Save as Pending for now.

& Add Spil Test =N E=R ="
Submit l‘(ﬁ Save as Pending Copy |_] Start Over 6 it
Laboratory: |A & L Canada j -
Customer: [Carter, Alexander (C0874) ~|" Fing

Reference:

T nomdo -

Notes A&L Only: If the submission contains samples from multiple farm fields, it will
be split into multiple submissions (one for each farm field) on Submit or Save
as Pending.

Pending submissions can be edited and submitted later.

s Soil/Tissue Test Submissions forms & labels could be

printed now for infernal

kil Add Soil Tests | s Add Tissue Tests ‘f Edit | <. Delete ‘ﬂ Mew Search Print Form Print Labels Q bl use only, or wait until
Submitted for a version

you can send to the Lab

Reference Submit Date ~ |Lab Customer Field Status
S5412430 Jul 07, 2017 AL Martin, Lyle Gordon & Carol's Pending “ 1
> |SSAL 2429 Jul 07, 2017 AL Martin, Lyle Home Quarter Pending “ 4
e M s e I 1T S R e T

temporary pending RefNo
will be updated by Lab on submission
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Caution You could print the submittal form and the bag labels for your own use while the submission is
Pending ... BUT ... don’t send those pending copies to the lab! Until the submission is complete
agré doesn’t have all the information the labs need to know.

. P Pending paperwork will not
GrnweriAlaxar-:ar,anar PENDING <4 be accepted bv the LabS .
e P : nple Submittal Form
Location/LLDSE 12-51-1 W5 .
O Cample- CART- Depth:0-5 \ A&L Canada Laboratories Inc.
SSAL2428
SUBMITTED BY: TSL Custom Ag & Fuel Inc. CLIENT/GROWER: Alexander Carter (00183)
Address: 335 Carleton Drive Address:  Box 14
City: St. Albert, Postal Code: T8N 711 City: DogRiver Postal Code: S0K 1T9
Phaone: 780.459.4477 Fax: 780.459.6405 | |Phone: 306.552.1903 Fax: 306.227.2246
Email: Email: debbiee@tronia.com Farm:
Account # Grower #:
LAB NUMBER | sSAMPLE
(Labuse only) NUMBER TESTS Depth LLD RECOMMENDATIONS
CART- SW1B2 0-6 |SE 12-51-1W5
e e e T T R e e

When the submission is ready, Submit it.

1l Test E\@

l Submit i Sawe as Pending Copy ,j Start Over w Exit
Laboratory” |A & L Canada ﬂ -
Customer: [Carter. Alexander (C0874) =" Find

Reference:

T nomdo -

You’ll be prompted to confirm your username and password (if you entered them in your User Config
Options) or be prompted to type them on the fly (but they won’t be saved).

Authenticate Soil Test Import @ Soil Test Submitted @

Username: [12345
Password: |"""’""""’1 :

Any Pending Reference number will be updated with one from the Lab.
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Submission Report

Notes Pending reports are incomplete and may be rejected by the Lab.

A&L Only: Submission Reports and Labels printed when pending will not
include the required bar code or the A&L User ID (it’s not entered until you
submit, so until then agré doesn’t know what it might be and thus cannot print
it) or A&L’s unique reference number assigned on submission.

Midwest Only: Reference numbers are assigned by Midwest on submission (so
there will be no reference number when the status is Pending).

When prompted to view the Label Submission report, click Yes and Print it to send along to the lab
with your samples.

the lab will scan barcode on receipt,
if's used to track your submission Soil Sample Submittal Form
A&L Canada Laboratories Inc.

your lab ID 95995-N3E3 L reference number from Lab

SUBMITTED BY: Tronia Testing Inc. CLIENT/GROWER:  Lyle Martin (C1000)

Address: 335 Carleton Drive Address: PO Box 18

ity St. Albert, Postal Code: T8N 7L1 City: Westlock Postal Code: TOg 312

Phone: 760459 4477 Fax: 780459 6405 Phone: 780.453.1200 Fax:

Email: Email: |.martin@martinfarms. Farm:

Account# 99995 Grower # Field: Home Quarter

LAB NUMBER | sSAMPLE

(Labuse only) NUMBER TESTS Depth LLD RECOMMENDATIONS
MART-1 SVW1B2 0-6 [MW27 47 18 W3 |Rec# Previous Crop Intended Crop  Yield Unit

1 VWheat Durum Canola &0 bu
2 Wheat Durum Wheat Durum 70 bu
3 WheatDurum  Wheat HR Winter 70 bu

Both A&L and Midwest have Batch Submission Reports if you’d rather print submissions reports for
multiple tests and/or multiple growers all at once instead of one at a time.
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Submission Labels

When prompted to view the Soil Bag Stickers, click Yes, Print them on labels, and attach them to the
soil sample bags (bag stickers are not required for tissue test submissions).

% AL Labels =3
JEreview < DStartOger ‘@ Exit |
Fow Start: I'I
| ifthe shest oflabels has
been partially used,
change the start row

Grower AlexsnderCarkr =l 53935
Farm:
Field:Fly Field
Location/LLD: SE 12-51-1 WS

Sample CART-034 Depth:0 -6

Grower:AlexsnderCariar
Farm:
Field:Fly Fizld
Location/LLD:SE 12-51-1'W5
Sample CART-037

99995

Depth: 5 - 12

Grower:AlexandarCariar EEEE Grower:AlexandarCarier ‘89985
Farm: Farm:
Field:Fly Fizld Field:Fly Field
Location/LLD:SE 12-51-1 W5 Location/LLD:SE 12-51-1 W8
Sample CART-035 Depth:0 -§ Sample CART-026 Depth: 0 -5
Grower:AlaxsnderCariar 99995
Farm:
Field:Fly Field
Location/LLD:SE 12-51-1 W5
Sample CART-038 Depth: § - 12

by o e N e T i i T e A APt A e et I P N e e AL e i

Note
For A&L, use Avery 5960.

When printing bag stickers/labels for Midwest, use Avery 45004.

The submission is listed on the Submit Soil Tests window with a status of Submitted.
The Reference number appears on both the Submission report and the Soil Bag Stickers).

& Soil/Tissue Test Submissions

[o ] & =]

J & Add Soil Tests | s Add Tissue Tests |.§@"‘u"|ew ‘ ¥ Delete |M New Search Print Form ‘ Print Labels |£3 Exit |

Reference Submit Date Lab Customer

=

Field Sample Count

99595-SSAL2421 | Jun 26, 2017
Jun 26, 2017

Jun 26, 2017

Carter, Alexander
Carter, Alexander
Carter, Alexander

AL

<Nt Assigned:

] »

Bobby's Field
Fly Field
Soggy Bottomn Creek

44 S0il/Tissue Test Submissions (Incl. 3 Pending) found

Lab Test Submissions
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Delete a Submitted Test

Until the results have downloaded/received submissions can be Deleted.

-

&# Soil/Tissue Test Submissions

(= &=

| @ A Soi Tests | s Add Tissue Tests | &' View || X Delete Ibﬂ New Search | ] Prnt Form | ] Pt Labels | € Ext |
e £

44 Soil/Tissue Test Submissions |

| Do you want to delete the lab submission 93995-55AL24217

Yes

Reference Submit Date = | Lab | Customer | Field Status Type |Sample Count | =
> |99995-55A12421 |Jun26, poz L Py Do Ciols Submitted W 51

59995-55A12420 | Jun 26, ] Confirm Delete 22 || submitted 7] 2

<Not Assigned> | Jun 26, Pending &; H(s

MNao |

Agronomy > Submit Soil/Tissue Tests

This cancels the submission in agré. You may also need to let the lab know you’ve deleted it.

Adyvise A & L of Deletion

To advise A & L that you have deleted a
submission, send them an email with the
following information:

To:
o Jeffiwalcanada.com

Subject:
e grower’s name
e reference number of the test submission
e Please Cancel

Attachments:
e copy of the soil test submission report

Body:
e request to cancel
e name

e company name
e cmail address
e phone number

Lab Test Submissions

Message WLES | Options | Format Text | Review | Adobe PDF

Paste Basic Mam
- N Tetr -

Clipboard =

lyle Martin-999.. & |
Q

Tell me...

es Include Tags

Office

Add-ins

Add-ins A
send an email to:

From - Microsoft Exchange / Jeﬁ@alcanada_com
=1
|Jeﬁ@almnada.mm ‘ |
Send
| Grower Name - Ref# -
— : Please Cancel
Subject |Ly|e Martin - 9995-554L203 - Please Cancel |
ttached lﬂzi Soil Test Submit - AL_2... < attach a copy of
16 KB the submission
leff,

Please cancel the atta
thanks!

Terry-Lynn Taylor
TSL Custom Ag & Fuel
titaylor@tsl.ltd

tell Jeff what you
44— wantto happen

on his end

ched test submission.

include your name,

(780) 555-1234

company, email address
& phone number
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Submitted Test Reporting

The Submission Form and the Soil Bag Stickers can viewed anytime from the Soil Test Submission

home form.
& Soil/Tissue Test Submissions =0 E=R =T
& Add Soil Tests | s Add Tissue Tests |.§@"‘u"|ew ‘ ¥ Delete |M New Search Print Form Print Labels ||® Exit |
Reference Submit Date = |Lab Customer Field Status Type |Sample Count | »
99595-SSAL2421 | Jun 26, 2017 AL Carter, Alexander Bobby's Field Submitted i 5]
99905-S5AL 2420 | Jun 26, 2017 AL Carter, Alexander Fly Field Submitted U 2
<Nt Assigned: Jun 26, 2017 Minf Carter, Alexander Soggy Bottomn Creek Pending & Al

44 S0il/Tissue Test Submissions (Incl. 3 Pending) found

Agronomy > Submit Soil/Tissue Tests

Batch versions can be printed from the menu.

Agronocmy

Reports 5 || Batch Reports » Field Information

Field Scout

Custom Application

Soil Test Labels AL

Soil Test Labels Midwest
Soil Test Submission (AL)
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